
Q .1Q .1 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सनेिक सने   लंद नलंद न   म�म�   आ यो �जतआ यो �जत   ती न�ती न�   गो लमेजगो लमेज   स�ेलन�स�ेलन�   म�म�   � �त भा ग� �त भा ग   िक यािक या   थाथा ??
A nsA ns 1. जवाहरलाल नेह(

2. महा*ा ग+धी
3. भीमराव अंबेडकर
4. लाला लाजपत राय

Q .2Q .2 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सेिक से   भा र ती यभा र ती य   जनताजनता   पा ट4पा ट4  ( B JP)   ( B JP)  केके   अ: दूतअ: दूत ,  ,  भा र ती यभा र ती य   जनसंघजनसंघ   केके   सं>ा प कसं>ा प क   केके   ( प( प   म�म�
जा नाजा ना   जा ताजा ता   हैहै ??

A nsA ns 1. एल. के . आडवाणी
2. दीनदयाल उपाCाय
3. Dामा �साद मुखज4
4. अटल �बहारF बाजपेयी

Q .3Q .3 जूनजून -- जुला ईजुला ई  2 0 24   2 0 24  म�म�   अफगा �नKा नअफगा �नKा न   प रप र   ती सराती सरा   संयुLसंयुL   रा MNरा MN   स�ेलनस�ेलन  ( Third  United Nations ( Third  United Nations
c onference)  c onference)  िक सिक स   >ा न>ा न   प रप र   आ यो �जतआ यो �जत   िक यािक या   ग याग या   थाथा ,  ,  �जसम��जसम�   प हलीप हली   बा रबा र   ता �लबा नता �लबा न   नेने   भीभी   भा गभा ग   �लया�लया
थाथा ??

A nsA ns 1. बगदाद
2. दुबई

3. तेहरान
4. दोहा

Q .4Q .4 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   अ\ध�नयमअ\ध�नयम   नेने   भा र तभा र त   केके   �लए�लए   एक] कृ तएक] कृ त   � शा सन� शा सन   काका   �नम` ण�नम` ण   िक यािक या ,  ,  �जसम��जसम�   बंगा लबंगा ल   केके
ग वनaरग वनaर   केके   अ\धका रअ\धका र   bेcbेc   म�म�   ती नती न   � ेसी ड� �सय�� ेसी ड� �सय�   कोको   ला याला या   ग याग या ??

A nsA ns 1. िपट्स इंिडया एf 1784
2. रेगुलेिटंग एf, 1773
3. भारत सरकार अ\ध�नयम, 1919
4. चाटaर अ\ध�नयम, 1813
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Q . 5Q . 5 बा लशा lीबा लशा lी   ज+ भेक रज+ भेक र   नेने   वष aवष a  _______  _______ म�म�   � थम� थम   आंoआंo -- मरा ठामरा ठा   समा चा रसमा चा र   प cप c  ' ' द प aणद पaण '  '  शु(शु(   िक यािक या ।।

A nsA ns 1. 1834
2. 1832
3. 1835
4. 1833

Q .6Q .6 जैवमंड ल�जैवमंड ल�  ( bios pheres)   ( bios pheres)  काका   कौ नकौ न -- सासा   समूहसमूह   असमअसम   म�म�   w> तw> त   हैहै ??
A nsA ns 1. सुंदरबन और पचमढ़F

2. शीत मz>ल और शेषाचलम
3. िड{ू-सैखोवा और मानस
4. प|ा और नंदा देवी

Q .7Q .7 अfू बरअfू बर  2 0 24   2 0 24  म�म� ,  ,  सु�ी मसु�ी म   को टaको टa   नेने   प रा लीप रा ली   जला नेजला ने   म�म�   सं�ल}सं�ल}   पा एपा ए   ग एग ए   िक सा न�िक सा न�   प रप र   मुक द मामुक द मा   चला नेचला ने   म�म�   �वफल�वफल
र हनेर हने   केके   �लए�लए  __________  __________ सर का र�सर का र�   कोको   फट का रफट का र   लगा ईलगा ई ।।

A nsA ns 1. ह~रयाणा और �बहार
2. ह~रयाणा और पंजाब
3. राज>ान और पंजाब
4. ह~रयाणा और राज>ान

Q .8Q .8 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   मुग लमुग ल   स�ा टस�ा ट   कोको   चौ साचौ सा   केके   यु�यु�   केके   दौ रा नदौ रा न   अफगा नअफगा न   शा सकशा सक   शेर शा हशेर शा ह   सूरFसूरF   नेने   प रा �जतप रा �जत
िक यािक या   थाथा ??

A nsA ns 1. जह+गीर
2. बाबर
3. अकबर
4. हुमायूं

Q .9Q .9 �जनेवा�जनेवा   म�म�   आ यो �जतआ यो �जत  2 0 2 5 BRS  CO Ps   2 0 2 5 BRS  CO Ps  म�म� ,  ,  प य` वर णप य` वर ण   मंcीमंcी   भूप ��भूप ��   या द वया द व   केके   नेत ृ�नेत ृ�   म�म�   भा र तभा र त   नेने   िक निक न   � मुख� मुख
bेc�bेc�   प रप र   बलबल   �द या�द या ??

A nsA ns 1. समु�ी संसाधन दोहन और अंत~रb मलबा �बंधन
2. वनो�ूलन नी�तय+ और वै��क काबaन मू� �नध`रण तंc
3. केवल जैव �व�वधता संरbण और जलवायु प~रवतaन �व�
4. �ा��क �दूषण, �व� और �ौ�ो�गक] तक पहंुच और ��न रासाय�नक अप�शM �बंधन
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Q .1 0Q .1 0 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   दे शदे श   नेने   �नवेशक��नवेशक�   काका   �व�ा स�व�ा स   सु�ढसु�ढ   क र नेक र ने   औ रऔ र   आ \थaकआ \थaक   सहयो गसहयो ग   कोको   बढ़ा वाबढ़ा वा   दे नेदे ने   केके
उ �ेDउ �ेD   सेसे   �सतंबर�सतंबर  2 0 24   2 0 24  म�म�   भा र तभा र त   केके   सा थसा थ   ��प bी य��प bी य   �नवेश�नवेश   सं\धसं\ध   प रप र   हKा bरहKा bर   िक एिक ए ??

A nsA ns 1. �+मार
2. मालदीव
3. उ�ेिकKान
4. �ीलंका

Q .1 1Q .1 1 भा र तभा र त   म�म�   प हलाप हला   जा सूसीजा सूसी   उ प : हउ प : ह ,  ,  �जसे�जसे   अ�ैलअ�ैल  2 0 24   2 0 24  त कत क   �ेसए��ेसए�   रॉ के टरॉ के ट   म�म�   लॉ �लॉ �   िक यािक या   जा नाजा ना   थाथा   औ रऔ र
�जसका�जसका   उ प यो गउ प यो ग   सशlसशl   बल�बल�   �ा रा�ा रा   ग ु}गु}   जा नका रFजा नका रF   �ा }�ा }   क र नेक र ने   केके   �लए�लए   िक यािक या   जा एगाजा एगा ,  ,  वहवह
_______________ _______________ �ा रा�ा रा   बना याबना या   ग याग या   हैहै ।।

A nsA ns 1. �हदंुKान एयरोनॉिट� �ल�मटेड
2. टाटा एडव+�ड �स�� �ल�मटेड
3. ए�N ोम टे�ोलॉजीज
4. भारतीय अंत~रb अनुसंधान संगठन (इसरो)

Q .1 2Q .1 2 वुलरवुलर   झी लझी ल   भा र तभा र त   केके   िक सिक स   क� �क� �   शा �सतशा �सत   � दे श� दे श   म�म�   w> तw> त   हैहै ??
A nsA ns 1. चंडीगढ़

2. ज�ू और क¡ीर
3. ल�ाख
4. �द¢ी

Q .1 3Q .1 3 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   आ *क थाआ *क था  ‘ ‘ आ ईआ ई   हैवहैव   दद   �N ी ट्स�N ी ट्स :  :  एए   कु ¥Fकु ¥F   ि¦ के टि¦ के ट   �ो रF�ो रF ’ ’ िक सनेिक सने   �लखी�लखी   हैहै ??
A nsA ns 1. र�वचं�न अ��न

2. जहीर खान
3. स¨चन त�दुलकर
4. हरभजन �संह

Q .1 4Q .1 4 भा र तभा र त   क]क]   जनग णनाजनग णना  2 0 1 1   2 0 1 1  केके   अनुसा रअनुसा र ,  ,  �न��ल	ख त�न��ल	ख त   म�म�   सेसे   �हंदू�हंदू   आ बा दीआ बा दी   काका   � �त शत� �त शत   िक सिक स   रा ©रा ©   म�म�
सव` \धकसव` \धक   हैहै ??

A nsA ns 1. �हमाचल �देश
2. असम
3. ओिडशा
4. म«णपुर
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Q .1 5Q .1 5 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   लो क सभालो क सभा   अCbअCb   नेने   लगा ता रलगा ता र   दोदो   लो कलो क   सभा ओंसभा ओं   क]क]   अCbताअCbता   क]क] ??
A nsA ns 1. �शवराज पािटल

2. मीरा कुमार
3. सोमनाथ चटज4
4. बलराम जाखड़

Q .1 6Q .1 6 ¨चcदुग a¨चcदुग a   लौ हलौ ह   अय­अय­   bेcbेc   िक सिक स   रा ©रा ©   म�म�   w> तw> त   हैहै ??
A nsA ns 1. �बहार

2. मC �देश
3. प�®म बंगाल
4. कन`टक

Q .1 7Q .1 7 भा र ती यभा र ती य   सं�वधा नसं�वधा न   केके   संद भaसंद भa   म�म� ,  ',  ' प ंथ�नर पेbपंथ�नर पेb  ( S ec ular) '   ( S ec ular) '  श±श±   काका   ²ा²ा   अथaअथa   हैहै ??
A nsA ns 1. राMN  का एक आ\धका~रक धमa है।

2. राMN  धा�मaक ³तंcता क] अनुम�त नह´ देता है।
3. राMN  एक धमa को दूसरे धमµ से ऊपर रखता है।
4. राMN  �बना िकसी आ\धका~रक धमa के सभी धमµ के साथ समान ·वहार करता है।

Q .1 8Q .1 8 भा र तभा र त   म�म�   क]क]   ग ईग ई   जनग णनाजनग णना   केके   संद भaसंद भa   म�म� ,  ,  �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सासा   क थनक थन   सहीसही   हैहै ??
A nsA ns 1. भारत म� जनगणना ��तवषa आयो�जत क] जाती है।

2.
जनगणना, मु¸ (प से नाग~रक� के आ\थaक डेटा एकc करने पर क� ��त है।

3. जनगणना म� ·ापक Kर पर जनस+¹¸क]य जानकारF एकc क] जाती है।
4. जनगणना का �बंधन संपूणaतः :ामीण �वकास मंcालय �ारा िकया जाता है।

Q .1 9Q .1 9 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   सहीसही   क थनक थन   काका   चयनचयन   क] �जएक] �जए ।।
A nsA ns 1. �सजदा क] �था अलाउ�ीन 	खलजी ने शु( क] थी।

2. 	खलजी वंश के अं�तम शासक क] ह»ा करके �द¢ी म� सै¼द वंश क] >ापना क] गई थी।
3. �सजदा एक �कार का अ\भवादन था �जसम� ·�L को घुटने के बल बैठकर अपने माथे से जमीन को छूना

होता था।
4. गुलाम वंश के बाद तुगलक� ने �द¢ी क] स�ा संभाली।
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Q .2 0Q .2 0 1 991 - 1 996 1 991 - 1 996 त कत क   भा र तभा र त   केके   � धा नमंcी� धा नमंcी   कौ नकौ न   थेथे ??
A nsA ns 1. चं�शेखर

2. एच.डी . देवेगौड़ा
3. पी .वी . नर�स¾ा राव
4. अटल �बहारF वाजपेयी

Q .2 1Q .2 1 नी चेनी चे   दीदी   ग ईग ई   सं¸ासं¸ा   ¿ंख ला¿ंख ला   काका   संद भaसंद भa   ली �जएली �जए   औ रऔ र   उ सकेउ सके   आ धा रआ धा र   प रप र   प ूछेप ूछे   ग एग ए   � À� À   काका   उ � रउ � र   दी �जएदी �जए । । ग णनाग णना
के वलके वल   बा एंबा एं   सेसे   दा एंदा एं   क]क]   जा नीजा नी   हैहै । (। ( सभीसभी   सं¸ा एंसं¸ा एं   एक लएक ल -- अंक] यअंक] य   सं¸ा एंसं¸ा एं   हÁहÁ । )।)

(( बा एंबा एं )  4  1  7  2  9  6  3  5 8  2  5 8  1  3  6  9  4  7  3  6  8  5 1  4  9  2  7  ()  4  1  7  2  9  6  3  5 8  2  5 8  1  3  6  9  4  7  3  6  8  5 1  4  9  2  7  ( दा एंदा एं ))

दीदी   ग ईग ई   ¿ंख ला¿ंख ला   म�म�   एकएक   प ूणaप ूणa   वगaवगa   सं¸ासं¸ा   केके   बा दबा द   एकएक   �वष म�वष म   सं¸ासं¸ा   िक त नीिक त नी   बा रबा र   आ यीआ यी   हैहै ??
A nsA ns 1. चार

2. दो
3. तीन
4. प+च

Q .2 2Q .2 2 एकएक   िट क टिट क ट   का उं ट रका उं ट र   प रप र ,  ,  �म�र�म�र  X  X  बा एंबा एं   सेसे  1 8 1 8 व�व�   औ रऔ र   दा एंदा एं   सेसे  24 24 व�व�   >ा न>ा न   प रप र   हÁहÁ । । उ सउ स   का उं ट रका उं ट र   प रप र   िक त नेिक त ने
लो गलो ग   हÁहÁ ??

A nsA ns 1. 
2. 
3. 
4. 

Q .2 3Q .2 3 �न��ल	ख त�न��ल	ख त   अbरअbर -- �ृंख ला�ृंख ला   काका   संद भaसंद भa   ली �जएली �जए   औ रऔ र   उ सकेउ सके   बा दबा द   आ नेआ ने   वा लेवा ले   � À� À   काका   उ � रउ � र   दी �जएदी �जए । । �ग नती�ग नती
के वलके वल   बा एंबा एं   सेसे   दा एंदा एं   क]क]   जा नीजा नी   हैहै ।।
(( बा एंबा एं   छो रछो र )  P  K J  U E  D  V  Z  R G  O  L  H F A  I  ()  P  K J  U E  D  V  Z  R G  O  L  H F A  I  ( दा एंदा एं   छो रछो र ))
उ प रो Lउ प रो L   �ृंख ला�ृंख ला   केके   बा एंबा एं   छो रछो र   सेसे   चौ थेचौ थे   अbरअbर   औ रऔ र   दा एंदा एं   छो रछो र   सेसे   छठेछठे   अbरअbर   केके   बी चबी च   िक त नेिक त ने   ·ंजन·ंजन   हÁहÁ ??

A nsA ns 1. तीन
2. चार
3. छह
4. पÍच

Section : Logical Reasoning
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Q .24Q .24 उ सउ स   �वक Î�वक Î   आ कृ �तआ कृ �त   काका   चयनचयन   क] �जएक] �जए   जोजो   प ैट नaप ैट नa   कोको   प ूराप ूरा   क र नेक र ने   केके   �लए�लए   नी चेनी चे   दीदी   ग ईग ई   आ कृ �तआ कृ �त   म�म�   � À� À   ¨चÏ¨चÏ
( ? )  ( ? )  केके   >ा न>ा न   प रप र   आ एगीआ एगी ।।

A nsA ns 1. 

2. 

3. 

4. 

Q .2 5Q .2 5 एकएक   �न�®त�न�®त   त रF केत रF के   सेसे  KJ  4   KJ  4  काका   संबंधसंबंध  M N 1 6   M N 1 6  सेसे   हैहै । । उ सीउ सी   � का र� का र ,  S G  1 3  ,  S G  1 3  काका   संबंधसंबंध  UK 52   UK 52  सेसे   हैहै । । समा नसमा न
त कaत कa   काका   अनुसर णअनुसर ण   क र तेक र ते   हुएहुए ,  E T  2 3  ,  E T  2 3  काका   संबंधसंबंध   �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक ससेिक ससे   हैहै ??

A nsA ns 1. HX 92
2. GY 90
3. HY 90
4. GX 92

Q .2 6Q .2 6 अं:ेजीअं: ेजी   वणaमा लावणaमा ला   ¦ म¦ म   केके   आ धा रआ धा र   प रप र ,  ,  �न��ल	ख त�न��ल	ख त   चा रचा र   अbरअbर -- समूह�समूह�   म�म�   सेसे   ती नती न   एकएक   �न�®त�न�®त   त रF केत रF के   सेसे
एक समा नएक समा न   हÁहÁ   औ रऔ र   इसइस   � का र� का र   एकएक   :ुप:ुप   बना तेबना ते   हÁहÁ । । कौ नकौ न -- सासा   अbरअbर -- समूहसमूह ,  ,  उ सउ स   :ुप:ुप   सेसे   संबं\धतसंबं\धत   नह´नह´   हैहै ??
(( नो टनो ट :  :  असंग तअसंग त   अbरअbर -- समूहसमूह ,  ,  ·ंजन�·ंजन� // ³र�³र�   क]क]   सं¸ासं¸ा   याया   उ नक]उ नक]   w> �तw> �त   प रप र   आ धा ~र तआ धा ~र त   नह´नह´   हैहै ।)।)

A nsA ns 1. NJI

2. PLI
3. DZY
4. XTS
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Q .2 7Q .2 7 1 2  1 2  एकएक   �न�®त�न�®त   त कaत कa   केके   अनुसा रअनुसा र  4 8  4 8 सेसे   संबं\धतसंबं\धत   हैहै । । उ सीउ सी   त कaत कa   केके   अनुसा रअनुसा र  7,  2 8   7,  2 8  सेसे   संबं\धतसंबं\धत   हैहै । । उ सीउ सी   त कaत कa
केके   अनुसा रअनुसा र ,  1 8  ,  1 8  �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक ससेिक ससे   संबं\धतसंबं\धत   हैहै ??

(( नो टनो ट :  :  सं¸ा ओंसं¸ा ओं   कोको   उ नकेउ नके   घ ट कघ ट क   अंक�अंक�   म�म�   तो ड़ेतो ड़े   �बना�बना ,  ,  संि¦ या एंसंि¦ या एं   प ूणaप ूणa   सं¸ा ओंसं¸ा ओं   प रप र   क]क]   जा नीजा नी   चा �हएचा �हए ।।
उ दा हर णउ दा हर ण   केके   �लए�लए  1 3   1 3  कोको   ली �जएली �जए -  1 3  -  1 3  प रप र   संि¦ या एंसंि¦ या एं   जैसेजैसे   िकिक  1 3   1 3  म�म�   जो ड़ नाजो ड़ ना // घ टा नाघ टा ना // गुणागुणा   क र नाक र ना   आ �दआ �द
िक यािक या   जाजा   सक तासक ता   हैहै । 1 3  । 1 3  कोको  1   1  औ रऔ र  3   3  म�म�   तो ड़ नातो ड़ ना   औ रऔ र   िफरिफर  1   1  औ रऔ र  3   3  प रप र   ग «णती यग «णती य   संि¦ या एंसंि¦ या एं   क र नेक र ने   क]क]
अनुम�तअनुम�त   नह´नह´   हैहै ।)।)

A nsA ns 1. 54
2. 72
3. 53
4. 73

Q .2 8Q .2 8 सा तसा त   · �L· �L , A ,  B,  C ,  D,  E ,  F  ,  A ,  B,  C ,  D,  E ,  F  औ रऔ र  G ,   G ,  उ � रउ � र   क]क]   ओ रओ र   अ\भमुखअ\भमुख   हो क रहो क र   एकएक   प ं�Lपं�L   म�म�   बैठेबैठे   हÁहÁ । A ,  F  । A ,  F  केके   बा एंबा एं
ती स रेती स रे   >ा न>ा न   प रप र   बैठाबैठा   हैहै । D  । D  औ रऔ र  F  F दो न�दो न�   काका   �नक ट त म�नक ट त म   प ड़ो सीप ड़ो सी  B   B  हैहै । D,  A  । D,  A  काका   �नक ट त म�नक ट त म   प ड़ो सीप ड़ो सी   नह´नह´   हैहै । F। F
औ रऔ र  G   G  दो न�दो न�   काका   �नक ट त म�नक ट त म   प ड़ो सीप ड़ो सी  C   C  हैहै । A ,  E  । A ,  E  केके   ठÓ कठÓ क   दा एंदा एं   प ड़ो सप ड़ो स   म�म�   बैठाबैठा   हैहै ।।
D D केके   सा प ेbसा पेb  A   A  काका   >ा न>ा न   ²ा²ा   हैहै ??

A nsA ns 1. बाएं से दूसरा
2. दाएं से प+चव+
3. बाएं से प+चव+
4. ठÓक दाएं पड़ोस म�

Q .2 9Q .2 9 य�दय�द  '− '   '− '  औ रऔ र  '÷ '   '÷ '  कोको   प र �रप र �र   बद लबद ल   �द या�द या   जा एजा ए   त थात था  '+ '   '+ '  औ रऔ र  '× '   ' × '  कोको   प र �रप र �र   बद लबद ल   �द या�द या   जा एजा ए ,  ,  तोतो
�न��ल	ख त�न��ल	ख त   समी क र णसमी क र ण   म�म�   � À� À -- ¨चÏ¨चÏ  ( ? )   ( ? )  केके   >ा न>ा न   प रप र   ²ा²ा   आ एगाआ एगा ??

3 8 + 54  − 6  ×  2  ÷  2  = ?3 8 + 54  − 6  ×  2  ÷  2  = ?
A nsA ns 1. 343

2. 344
3. 342
4. 345
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Q .3 0Q .3 0 K,  F K ,  F  क]क]   मा तामा ता   हैहै । F,  P  । F,  P  क]क]   बहनबहन   हैहै । M ,  E  । M ,  E  काका   प ुcप ुc   हैहै । E ,  P  । E ,  P  काका   प �तप �त   हैहै । F  । F काका  M   M  सेसे   ²ा²ा   संबंधसंबंध   हैहै ??
A nsA ns 1. िपता क] बहन

2. बहन का प�त
3. पÙी का भाई
4. माता क] बहन

Q .3 1Q .3 1 दीदी   ग ईग ई   ¿ंख ला¿ंख ला   म�म�   � À� À -- ¨चÏ¨चÏ  ( ? )   ( ? )  केके   >ा न>ा न   कौ नकौ न -- सीसी   सं¸ासं¸ा   आ नीआ नी   चा �हएचा �हए ??

74 1  74 1  74 9 74 9 757  757  765 765 773  773  ?  ?  
A nsA ns 1. 

2. 
3. 
4. 

Q .3 2Q .3 2 य�दय�द  ' × '   ' × '  औ रऔ र  '−'   '− '  कोको   प र �रप र �र   बद लबद ल   �द या�द या   जा एजा ए   त थात था  '÷ '   '÷ '  औ रऔ र  '+ '   '+ '  कोको   प र �रप र �र   बद लबद ल   �द या�द या   जा एजा ए ,  ,  तोतो
�न��ल	ख त�न��ल	ख त   समी क र णसमी क र ण   म�म�   � À� À -- ¨चÏ¨चÏ  ( ? )   ( ? )  केके   >ा न>ा न   प रप र   ²ा²ा   आ एगाआ एगा ??

3 3 3  + 3 7  − 7  ÷  66 ×  4 9 = ?3 3 3  + 3 7  − 7  ÷  66 ×  4 9 = ?
A nsA ns 1. 75

2. 69
3. 67
4. 80

Q .3 3Q .3 3 उ सउ स   युग ्युग ्मम   काका   चयनचयन   क र�क र�   जोजो   नी चेनी चे   �द ये�द ये   ग येग ये   युÚ�युÚ�   केके   समा नसमा न   प ैट नaप ैट नa   काका   अनुसर णअनुसर ण   क र ताक र ता   हैहै । । दो न�दो न�   युग ्युग ्मम   एकएक
हीही   प ैट नaप ैट नa   काका   अनुसर णअनुसर ण   क र तेक र ते   हÁहÁ ।।
Q PL −NM IQ PL −NM I
O NJ−L KGO NJ−L KG

A nsA ns 1. DCY−ZZU 
2. DCY−AZV 
3. DBW−AZV
4. DBW−ZYU
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Q .3 4Q .3 4 �न��ल	ख त�न��ल	ख त   श±�श±�   केके   ती नती न   युÚयुÚ   एकएक   �न�®त�न�®त   � का र� का र   सेसे   एकएक   समा नसमा न   हÁहÁ   औ रऔ र   इसइस   � का र� का र   एकएक   समूहसमूह   बना तेबना ते   हÁहÁ ।।
कौ नकौ न -- सासा   श±श± -- युÚयुÚ   उ सउ स   समूहसमूह   सेसे   संबं\धतसंबं\धत   नह´नह´   हैहै ??

A nsA ns 1. कार - �ीय~रंग
2. नाव - रडर
3. मोटरबाइक - पैडल
4. हवाई जहाज - ऐलेरॉन

Q .3 5Q .3 5 �न��ल	ख त�न��ल	ख त   सं¸ासं¸ा   ¿ंख ला¿ंख ला   काका   संद भaसंद भa   ली �जएली �जए   औ रऔ र   �द ए�द ए   ग एग ए   � À� À   काका   उ � रउ � र   दी �जएदी �जए । (। ( सभीसभी   सं¸ा एँसं¸ा एँ   के वलके वल
एकएक   अंकअंक   वा लीवा ली   सं¸ा एँसं¸ा एँ   हÁहÁ ))

(( बा एंबा एं )  2  4  6  7  2  1  7  9  0  5 3  2  3  2  1  3  6  8  8  6  5 4  5 7  8  8  4  4  6  4  8  0  9  7  9  7  3  ()  2  4  6  7  2  1  7  9  0  5 3  2  3  2  1  3  6  8  8  6  5 4  5 7  8  8  4  4  6  4  8  0  9  7  9  7  3  ( दा एंदा एं ))

ऐसेऐसे   िक त नेिक त ने   �वष म�वष म   अंकअंक   हÁहÁ ,  ,  �जनम��जनम�   सेसे   � »ेक� »ेक   केके   ठÓ कठÓ क   प हलेप हले   एकएक   समसम   अंकअंक   हैहै   औ रऔ र   ठÓ कठÓ क   बा दबा द   म�म�   एकएक   �वष म�वष म
अंकअंक   हैहै ??
(( नो टनो ट :  :  शूÞशूÞ   कोको   एकएक   समसम   सं¸ासं¸ा   मा नामा ना   जा नाजा ना   चा �हएचा �हए ।)।)

A nsA ns 1. छह
2. प+च
3. तीन
4. चार

Q .3 6Q .3 6 दीदी   ग ईग ई   ¿ंख ला¿ंख ला   काका   संद भaसंद भa   ली �जएली �जए   औ रऔ र   उ सकेउ सके   बा दबा द   �द ए�द ए   ग एग ए   � À� À   काका   उ � रउ � र   दी �जएदी �जए । । �ग नती�ग नती   के वलके वल   बा एंबा एं   सेसे
दा एंदा एं   क]क]   जा नीजा नी   चा �हएचा �हए । (। ( सभीसभी   सं¸ा एँसं¸ा एँ   के वलके वल   एकएक   अंकअंक   वा लीवा ली   सं¸ा एँसं¸ा एँ   हÁहÁ ))

(( बा एंबा एं )  7  8  7  7  3  9  2  6  7  4  6  8  9  9  6  4  3  2  3  7  8  3  5 8  5 5 3  ()  7  8  7  7  3  9  2  6  7  4  6  8  9  9  6  4  3  2  3  7  8  3  5 8  5 5 3  ( दा एंदा एं ))

ऐसीऐसी   िक त नीिक त नी   समसम   सं¸ा एँसं¸ा एँ   हÁहÁ ,  ,  �जनम��जनम�   सेसे   � »ेक� »ेक   केके   ठÓ कठÓ क   प हलेप हले   एकएक   �वष म�वष म   सं¸ासं¸ा   हैहै   औ रऔ र   ठÓ कठÓ क   बा दबा द   म�म�   भीभी   एकएक
�वष म�वष म   सं¸ासं¸ा   हैहै ??

A nsA ns 1. चार
2. एक
3. दो
4. पÍच
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Q .3 7Q .3 7 दीदी   ग ईग ई   �ृंख ला�ृंख ला   म�म�   � À� À -- ¨चÏ¨चÏ  ( ? )   ( ? )  केके   >ा न>ा न   प रप र   ²ा²ा   आ नाआ ना   चा �हएचा �हए ??

3  3  ?  ?  1 2  1 2  3 9 3 9 1 0 3  1 0 3  2 2 82 2 8
A nsA ns 1. 4

2. 6
3. 8
4. 10

Q .3 8Q .3 8 य�दय�द  ‘× ’  ‘× ’ औ रऔ र  ‘−’  ‘− ’ कोको   प र �रप र �र   बद लबद ल   �द या�द या   जा एजा ए   त थात था  ‘÷ ’  ‘÷ ’ औ रऔ र  ‘+ ’  ‘+ ’ कोको   प र �रप र �र   बद लबद ल   �द या�द या   जा एजा ए ,  ,  तोतो
�न��ल	ख त�न��ल	ख त   समी क र णसमी क र ण   म�म�   � À� À -- ¨चÏ¨चÏ  ( ? )   ( ? )  केके   >ा न>ा न   प रप र   ²ा²ा   आ एगाआ एगा ??

1 1 4  + 3  − 2 5 ÷  4 1  ×  2 0  = ?1 1 4  + 3  − 2 5 ÷  4 1  ×  2 0  = ?
A nsA ns 1. 943

2. 963
3. 971
4. 956

Q .3 9Q .3 9 एकएक   �न�®त�न�®त   त कaत कa   काका   अनुसर णअनुसर ण   क र तेक र ते   हुएहुए ,  9  ,  9  काका   संबंधसंबंध  54   54  सेसे   हैहै । । उ सीउ सी   त कaत कa   काका   अनुसर णअनुसर ण   क र तेक र ते   हुएहुए ,  1 3  ,  1 3  काका
संबंधसंबंध  74   74  सेसे   हैहै । । उ सीउ सी   त कaत कa   काका   अनुसर णअनुसर ण   क र तेक र ते   हुएहुए ,  2 2  ,  2 2  काका   संबंधसंबंध   �द ए�द ए   ग एग ए   �वक Î��वक Î�   म�म�   सेसे   िक ससेिक ससे   हैहै ??

(( नो टनो ट :  :  सं¸ा ओंसं¸ा ओं   कोको   उ नकेउ नके   घ ट कघ ट क   अंक�अंक�   म�म�   तो ड़ेतो ड़े   �बना�बना ,  ,  प ूणaप ूणa   सं¸ा ओंसं¸ा ओं   प रप र   संि¦ या एँसंि¦ या एँ   क]क]   जा नीजा नी   चा �हएचा �हए ।।
उ दा हर णउ दा हर ण   केके   �लए�लए  1 3   1 3  कोको   ली �जएली �जए  -  1 3   -  1 3  प रप र   संि¦ या एँसंि¦ या एँ ,  ,  जैसेजैसे   िकिक  1 3   1 3  म�म�   जो ड़ नाजो ड़ ना // घ टा नाघ टा ना // गुणागुणा   क र नाक र ना   आ �दआ �द ,  ,  प रप र
क]क]   जाजा   सक तीसक ती   हÁहÁ । 1 3  । 1 3  कोको  1   1  औ रऔ र  3   3  म�म�   तो ड़ नातो ड़ ना   औ रऔ र   िफरिफर  1   1  औ रऔ र  3   3  प रप र   ग «णती यग «णती य   संि¦ या एँसंि¦ या एँ   क र नेक र ने   क]क]   अनुम�तअनुम�त
नह´नह´   हैहै ।)।)

A nsA ns 1. 119
2. 132
3. 142
4. 124

Q .4 0Q .4 0 अं:ेजीअं: ेजी   वणaमा लावणaमा ला   ¦ म¦ म   केके   आ धा रआ धा र   प रप र  A DV IC E   A DV IC E  एकएक   �न�®त�न�®त   त रF केत रF के   सेसे  Y ITNA J   Y ITNA J  सेसे   संबं\धतसंबं\धत   हैहै । । उ सीउ सी   त र हत र ह
G ATE ,  E FRJ  G ATE ,  E FRJ  सेसे   संबं\धतसंबं\धत   हैहै । । उ सीउ सी   त कaत कa   काका   अनुसर णअनुसर ण   क र तेक र ते   हुएहुए ,  WE A LTH ,  WE A LTH �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक ससेिक ससे
संबं\धतसंबं\धत   हैहै ??

A nsA ns 1. 
2. 
3. 
4. 
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Q .4 1Q .4 1 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

The mother  s tarted to  marinate the c hic ken _______ .The mother  s tarted to  marinate the c hic ken _______ .
A nsA ns 1. yesterday

2. earliest
3. tomorrow
4. while

Q .4 2Q .4 2 S elec t  the mos t appropr iate meaning of the given id iom.S elec t  the mos t appropr iate meaning of the given id iom.
Throw in the towelThrow in the towel

A nsA ns 1. To give up or surrender
2. To celebrate a victory
3. To make a strong comeback
4. To start something new

Q .43Q .43 S elec t  the mos t appropr iate option to  fil l  in the blank .S elec t  the mos t appropr iate option to  fil l  in the blank .

I  __________ that  they  are going to  bui ld  a  new s ports  c omplex .I  __________ that  they  are going to  bui ld  a  new s ports  c omplex .
A nsA ns 1. hear

2. hears
3. listen
4. hearing

Q .4 4Q .4 4 S elec t  the mos t appropr iate A NTO NYM  of the given word .S elec t  the mos t appropr iate A NTO NYM  of the given word .

Rus t icRus t ic
A nsA ns 1. Rural

2. Bucolic
3. Urban
4. Pastoral

Section : General English and Comprehension
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Q .4 5Q .4 5 S elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given groupS elec t  the option that  c an be us ed as  a  one- word s ubs t itute for  the given group
of words .of  words .

Inc apable of being s eenInc apable of being s een
A nsA ns 1. Inaudible

2. Intangible
3. Invincible
4. Invisible

C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

I  emerged into the hot sunshine and stood on the steps of the Bank, where I  had
stood as a small boy some fifteen years back, waiting for granny to finish her
work — I think she had been the only one in the family to put some money by for
a rainy day — but these had been rainy days for her sons and daughters and
various fickle relatives who were always battening off her. Her own needs were
few. She lived in one room of her house, leaving the rest of it for the family to
use. When she died, the house was sold so that her children could once more go
their impecunious ways. 

I  had no relatives to support, but here was Williams Matheson waiting for me
under the old peepal tree. His hands were shaking.

S ubQ ues t ion No :  4 6S ubQ ues t ion No :  4 6
Q .4 6Q .4 6 S elec t  the mos t appropr iate theme for  the pas s age.S elec t  the mos t appropr iate theme for  the pas s age.
A nsA ns 1. A nostalgic reflection on family and loss

2. Financial planning for retirement
3. The importance of education

4. Conflicts between generations
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

I  emerged into the hot sunshine and stood on the steps of the Bank, where I  had
stood as a small boy some fifteen years back, waiting for granny to finish her
work — I think she had been the only one in the family to put some money by for
a rainy day — but these had been rainy days for her sons and daughters and
various fickle relatives who were always battening off her. Her own needs were
few. She lived in one room of her house, leaving the rest of it for the family to
use. When she died, the house was sold so that her children could once more go
their impecunious ways. 

I  had no relatives to support, but here was Williams Matheson waiting for me
under the old peepal tree. His hands were shaking.

S ubQ ues t ion No :  47S ubQ ues t ion No :  47
Q .47Q .47 S elec t  the mos t appropr iate A NTO NYM  of the word 'fic k le' .S elec t  the mos t appropr iate A NTO NYM  of the word 'fic k le' .
A nsA ns 1. Steadfast

2. Temporary
3. Unpredictable
4. Superficial
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C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

I  emerged into the hot sunshine and stood on the steps of the Bank, where I  had
stood as a small boy some fifteen years back, waiting for granny to finish her
work — I think she had been the only one in the family to put some money by for
a rainy day — but these had been rainy days for her sons and daughters and
various fickle relatives who were always battening off her. Her own needs were
few. She lived in one room of her house, leaving the rest of it for the family to
use. When she died, the house was sold so that her children could once more go
their impecunious ways. 

I  had no relatives to support, but here was Williams Matheson waiting for me
under the old peepal tree. His hands were shaking.

S ubQ ues t ion No :  4 8S ubQ ues t ion No :  4 8
Q .4 8Q .4 8 S elec t  the mos t appropr iate tone of the pas s age.S elec t  the mos t appropr iate tone of the pas s age.
A nsA ns 1. Affectionate

2. Indifferent
3. Resentful
4. Bitter

C omprehens ion:C omprehens ion:
Read the given passage and answer the questions that follow.

I  emerged into the hot sunshine and stood on the steps of the Bank, where I  had
stood as a small boy some fifteen years back, waiting for granny to finish her
work — I think she had been the only one in the family to put some money by for
a rainy day — but these had been rainy days for her sons and daughters and
various fickle relatives who were always battening off her. Her own needs were
few. She lived in one room of her house, leaving the rest of it for the family to
use. When she died, the house was sold so that her children could once more go
their impecunious ways. 

I  had no relatives to support, but here was Williams Matheson waiting for me
under the old peepal tree. His hands were shaking.

S ubQ ues t ion No :  4 9S ubQ ues t ion No :  4 9
Q .4 9Q .4 9 S elec t  the mos t appropr iate inference that  c an be drawn about the wr iter 'sS elec t  the mos t appropr iate inference that  c an be drawn about the wr iter 's

att itude toward the grandmother  and her  c hi ldren.att itude toward the grandmother  and her  c hi ldren.
A nsA ns 1. He is indifferent to his grandmother’s life and choices.

2. He blames his grandmother for not helping her children enough.
3. He feels admiration for her frugality and disapproves of her children’s dependence.
4. He believes she should have spent more money on herself.
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C omprehens ion:C omprehens ion:

Read the given passage and answer the questions that follow.

I  emerged into the hot sunshine and stood on the steps of the Bank, where I  had
stood as a small boy some fifteen years back, waiting for granny to finish her
work — I think she had been the only one in the family to put some money by for
a rainy day — but these had been rainy days for her sons and daughters and
various fickle relatives who were always battening off her. Her own needs were
few. She lived in one room of her house, leaving the rest of it for the family to
use. When she died, the house was sold so that her children could once more go
their impecunious ways. 

I  had no relatives to support, but here was Williams Matheson waiting for me
under the old peepal tree. His hands were shaking.

S ubQ ues t ion No :  50S ubQ ues t ion No :  50
Q . 50Q . 50 S elec t  the mos t appropr iate s y nony m of the word ' impec unious ' .S elec t  the mos t appropr iate s y nony m of the word ' impec unious ' .
A nsA ns 1. Abundant

2. Ungrudging
3. Impoverished
4. Wealthy

Q . 51Q . 51 '' अप नीअप नी   क र नीक र नी   पा रपा र   उ त र नीउ त र नी '  '  लो को �Lलो को �L   काका   सहीसही   अथaअथa   हो गाहो गा --
A nsA ns 1. मनमानी करना

2. अपने िकये का फल भोगना
3. अÞाय का बोलबाला
4. बेसहारे का सहारा

Q . 52Q . 52 '' शो «णतशो «णत '  '  काका   प य` यवा चीप य` यवा ची   श±श±   हो गाहो गा
A nsA ns 1. शुनक

2. z\धर
3. कूल
4. �शव

Section : General Hindi and Comprehension
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Q . 53Q . 53 ि¦ याि¦ या   काका   उ ¨चतउ ¨चत   ( प( प   ~र L~र L   >ा न>ा न   म�म�   भर�भर�
मÁमÁ   प c . . . . . . . . . . . . . . . . हँूप c . . . . . . . . . . . . . . . . हँू ।।

A nsA ns 1. �लखना
2. �लखूंगा
3. �लखता
4. लेखक

Q . 54Q . 54 '' é�é� '  '  काका   �वलो म�वलो म   श±श±   हो गाहो गा
A nsA ns 1. उथला

2. ल�घमा
3. महान्
4. अ:ाê

Q . 55Q . 55 �न��ल	ख त�न��ल	ख त   लो को �Lलो को �L   काका   सहीसही   अथaअथa   प हचा न�प हचा न� ।।
बुिढ़ याबुिढ़ या   मरFमरF   तोतो   आ ग राआ ग रा   तोतो   दे खादे खा ।।

A nsA ns 1. हर बात के अëे-बुरे दो पहलू होते हÁ।
2. िकसी दु¡न का दूर हो जाना
3. बहुत खुश होना
4. िकसी को याद न करना
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C omprehens ion:C omprehens ion:
�दए गए ग�+श के आधार पर �न��ल	खत �À� के उ�र दी�जए।

‘महाका·’ को �बंध का· भी कहते हÁ। पा®ा» सा�ह» म� इसके �लए ‘एिपक’ श± का �योग िकया जाता है । यह
अ»ंत �ाचीन का· �वधा है। हमारे यहÍ रामायण और महाभारत जैसे �वशाल महाका· �लखे गए हÁ, �जì� उपजी·
क�वय भी कहा जाता है, ²�िक ये परवत4 का·� और महाका·� के íोत भी हÁ। इस�लए �ाचीन समय से इस �वधा
के ³(प एवं लbण� पर �वचार िकया जाता रहा है। महाका· ‘महत्’ और ‘का·’ इन दो श±� से ·ुî| पद है।
‘का·’ के साथ महत् श± का �योग सबसे पहले वाïीिक-‘रामायण’ म� �मलता है-“कत` का·ñ महत: ò चासौ
मु�नपुंगव: ।” इस पं�L से महाका· के तीन लbण� पर �काश पड़ता है- महाका· के आकार क] �वशालता, िकसी
महान च~रc क] ��तôा और �णेता क] महानता।भारतीय का·शाl म� संभवत : सवa�थम आचायa भामह ने
महाका· के ³(प –�नध`रण का �यास िकया।उì�ने ³(प �वधान के आधार पर का· के प+च भेद िकए हÁ।
महाका· उनम� से एक है।

S ubQ ues t ion No :  56S ubQ ues t ion No :  56
Q . 56Q . 56 '' का ·का · '  '  केके   सा थसा थ   महत्महत्   श±श±   काका   � यो ग� यो ग   सबसेसबसे   प हलेप हले   क हÍक हÍ   �मलता�मलता   हैहै ??
A nsA ns 1. वाïीिक-रामायण म�

2. कबीरदास- बीजक म�
3. तुलसीदास- रामच~रतमानस म�
4. सूरदास -सूरसागर म�
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C omprehens ion:C omprehens ion:
�दए गए ग�+श के आधार पर �न��ल	खत �À� के उ�र दी�जए।

‘महाका·’ को �बंध का· भी कहते हÁ। पा®ा» सा�ह» म� इसके �लए ‘एिपक’ श± का �योग िकया जाता है । यह
अ»ंत �ाचीन का· �वधा है। हमारे यहÍ रामायण और महाभारत जैसे �वशाल महाका· �लखे गए हÁ, �जì� उपजी·
क�वय भी कहा जाता है, ²�िक ये परवत4 का·� और महाका·� के íोत भी हÁ। इस�लए �ाचीन समय से इस �वधा
के ³(प एवं लbण� पर �वचार िकया जाता रहा है। महाका· ‘महत्’ और ‘का·’ इन दो श±� से ·ुî| पद है।
‘का·’ के साथ महत् श± का �योग सबसे पहले वाïीिक-‘रामायण’ म� �मलता है-“कत` का·ñ महत: ò चासौ
मु�नपुंगव: ।” इस पं�L से महाका· के तीन लbण� पर �काश पड़ता है- महाका· के आकार क] �वशालता, िकसी
महान च~रc क] ��तôा और �णेता क] महानता।भारतीय का·शाl म� संभवत : सवa�थम आचायa भामह ने
महाका· के ³(प –�नध`रण का �यास िकया।उì�ने ³(प �वधान के आधार पर का· के प+च भेद िकए हÁ।
महाका· उनम� से एक है।

S ubQ ues t ion No :  57S ubQ ues t ion No :  57
Q . 57Q . 57 महा का ·महा का ·   िक निक न   दोदो   श±�श±�   सेसे   ·ुî|·ुî|   प दप द   हैहै  ? ?
A nsA ns 1. लघु और दीघa

2 . महान और छु�
3. महत् और का·
4. उप और Þास
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C omprehens ion:C omprehens ion:
�दए गए ग�+श के आधार पर �न��ल	खत �À� के उ�र दी�जए।

‘महाका·’ को �बंध का· भी कहते हÁ। पा®ा» सा�ह» म� इसके �लए ‘एिपक’ श± का �योग िकया जाता है । यह
अ»ंत �ाचीन का· �वधा है। हमारे यहÍ रामायण और महाभारत जैसे �वशाल महाका· �लखे गए हÁ, �जì� उपजी·
क�वय भी कहा जाता है, ²�िक ये परवत4 का·� और महाका·� के íोत भी हÁ। इस�लए �ाचीन समय से इस �वधा
के ³(प एवं लbण� पर �वचार िकया जाता रहा है। महाका· ‘महत्’ और ‘का·’ इन दो श±� से ·ुî| पद है।
‘का·’ के साथ महत् श± का �योग सबसे पहले वाïीिक-‘रामायण’ म� �मलता है-“कत` का·ñ महत: ò चासौ
मु�नपुंगव: ।” इस पं�L से महाका· के तीन लbण� पर �काश पड़ता है- महाका· के आकार क] �वशालता, िकसी
महान च~रc क] ��तôा और �णेता क] महानता।भारतीय का·शाl म� संभवत : सवa�थम आचायa भामह ने
महाका· के ³(प –�नध`रण का �यास िकया।उì�ने ³(प �वधान के आधार पर का· के प+च भेद िकए हÁ।
महाका· उनम� से एक है।

S ubQ ues t ion No :  58S ubQ ues t ion No :  58
Q . 58Q . 58 ग �+ शग �+ श   म�म�   � युL� युL   उ प जी ·उ प जी ·   काका   अथaअथa   ²ा²ा   हैहै  ? ?
A nsA ns 1. �जसके होने से भय लगता हो

2. �जसके सहारे जीवन चलता हो
3. �जसके आने से सुख �मले
4. �जसके नाम से रा© चलता हो
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C omprehens ion:C omprehens ion:
�दए गए ग�+श के आधार पर �न��ल	खत �À� के उ�र दी�जए।

‘महाका·’ को �बंध का· भी कहते हÁ। पा®ा» सा�ह» म� इसके �लए ‘एिपक’ श± का �योग िकया जाता है । यह
अ»ंत �ाचीन का· �वधा है। हमारे यहÍ रामायण और महाभारत जैसे �वशाल महाका· �लखे गए हÁ, �जì� उपजी·
क�वय भी कहा जाता है, ²�िक ये परवत4 का·� और महाका·� के íोत भी हÁ। इस�लए �ाचीन समय से इस �वधा
के ³(प एवं लbण� पर �वचार िकया जाता रहा है। महाका· ‘महत्’ और ‘का·’ इन दो श±� से ·ुî| पद है।
‘का·’ के साथ महत् श± का �योग सबसे पहले वाïीिक-‘रामायण’ म� �मलता है-“कत` का·ñ महत: ò चासौ
मु�नपुंगव: ।” इस पं�L से महाका· के तीन लbण� पर �काश पड़ता है- महाका· के आकार क] �वशालता, िकसी
महान च~रc क] ��तôा और �णेता क] महानता।भारतीय का·शाl म� संभवत : सवa�थम आचायa भामह ने
महाका· के ³(प –�नध`रण का �यास िकया।उì�ने ³(प �वधान के आधार पर का· के प+च भेद िकए हÁ।
महाका· उनम� से एक है।

S ubQ ues t ion No :  59S ubQ ues t ion No :  59
Q . 59Q . 59 ग �+ शग �+ श   म�म�   � युL� युL   �ा ची न�ा ची न   काका   �वलो म�वलो म   श±श±   हो गाहो गा  - -
A nsA ns 1. अव`चीन

2. परोb
3. पzष
4. आ�दम
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C omprehens ion:C omprehens ion:
�दए गए ग�+श के आधार पर �न��ल	खत �À� के उ�र दी�जए।

‘महाका·’ को �बंध का· भी कहते हÁ। पा®ा» सा�ह» म� इसके �लए ‘एिपक’ श± का �योग िकया जाता है । यह
अ»ंत �ाचीन का· �वधा है। हमारे यहÍ रामायण और महाभारत जैसे �वशाल महाका· �लखे गए हÁ, �जì� उपजी·
क�वय भी कहा जाता है, ²�िक ये परवत4 का·� और महाका·� के íोत भी हÁ। इस�लए �ाचीन समय से इस �वधा
के ³(प एवं लbण� पर �वचार िकया जाता रहा है। महाका· ‘महत्’ और ‘का·’ इन दो श±� से ·ुî| पद है।
‘का·’ के साथ महत् श± का �योग सबसे पहले वाïीिक-‘रामायण’ म� �मलता है-“कत` का·ñ महत: ò चासौ
मु�नपुंगव: ।” इस पं�L से महाका· के तीन लbण� पर �काश पड़ता है- महाका· के आकार क] �वशालता, िकसी
महान च~रc क] ��तôा और �णेता क] महानता।भारतीय का·शाl म� संभवत : सवa�थम आचायa भामह ने
महाका· के ³(प –�नध`रण का �यास िकया।उì�ने ³(प �वधान के आधार पर का· के प+च भेद िकए हÁ।
महाका· उनम� से एक है।

S ubQ ues t ion No :  60S ubQ ues t ion No :  60
Q .60Q .60 ग �+ शग �+ श   केके   �लए�लए   उ प युLउ प युL   शी ष aकशी षaक   काका   चयनचयन   क] �जएक] �जए ।।
A nsA ns 1. च~रत का·

2. महाका·
3. खंडका·
4. मुLक का·

Q .61Q .61 वडaवडa   �ो से�स ंग�ो से�स ंग   सॉ öवेयरसॉ öवेयर   म�म�  'Undo '   'Undo '  फ़ंø नफ़ंø न   काका   ²ा²ा   का यaका यa   हैहै ??
A nsA ns 1. नया डा²ूम�ट बनाना

2. ला� एøन को सेव करना
3. ला� एøन को कÁ �सल करना
4. ला� एøन को ~रपीट करना

Q .62Q .62 एमएसएमएस -- ए�ेलए�ेल  2 0 1 0   2 0 1 0  म�म�   सटी कसटी क   कॉ लमकॉ लम   क]क]   चौ ड़ा ईचौ ड़ा ई   कै सेकै से   सेटसेट   क रक र   सक तेसक ते   हÁहÁ ??
A nsA ns 1. कॉलम हेिडंग (column heading) पर डबल-ùúक करके।

2. कॉलम �सलेक्ट करके, 'Home> Format> Column Width' पर जाकर, और सटीक सं¸ा इनपुट
करके।

3. कॉलम हेिडंग (column heading) पर राइट-ùúक करके और 'Set Width' �सलेक्ट करके।
4. 'Insert' टैब पर जाकर और कॉलम 'Settings' �सलेक्ट करके।

Section : Basic Knowledge of Computer
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Q .63Q .63 �व ंडो ज़�व ंडो ज़   म�म�   डे ­टॉ पडे ­टॉ प   प रप र   ~र यल~र यल   टा इमटा इम   úॉ कúॉ क   क ह+क ह+   िड ��ेिड ��े   हो तीहो ती   हैहै ??
A nsA ns 1. टा­बार के बीच म�

2 . टा­बार के दाý ओर
3. टा­बार के बाý ओर
4. þ]न के सबसे ऊपर

Q .64Q .64 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सासा   क थनक थन   सवÿ त्सवÿ त्त मत म   � का र� का र   सेसे   वणaनवणaन   क र ताक र ता   हैहै ,  ,  िकिक   एंटी वा यर सएंटी वा यर स   सॉ öवेयरसॉ öवेयर   कं Āूट रकं Āूट र
कोको   वा यर सवा यर स   सेसे   कै सेकै से   �ो टे क्�ो टे क् टट   क र ताक र ता   हैहै ??

A nsA ns 1. यह कंĀूटर को िकसी भी नेटवकa  से कनेf होने से रोकता है, �जससे वायरस का टN +स�मशन zक जाता है।
2. यह āात वायरस �सĂेचर के �लए फाइल� और �ो:ाम� को ­ैन करता है और सं�दă फाइल� को पृथक

करता है।
3. यह कंĀूटर से जुड़े  सभी बाहरF िडवाइस� तक पहंुच को ब्लॉक कर देता है।
4. यह वायरस इंफेक्शन को रोकने के �लए इंटरनेट से सभी डाउनलोड क] गई फ़ाइल� को िडलीट कर देता है।

Q .65Q .65 ई मेलई मेल   कॉ िĄफ़ग रे शनकॉ िĄफ़ ग रे शन   म�म� ,  ,  �स²ो र�स²ो र   सॉ के टसॉ के ट   लेयरलेयर // टN + सपो टaटN + सपो टa   लेयरलेयर   �स²ो ~र टी�स²ो ~र टी  ( S S L / TL S )   ( S S L / TL S )  काका   ²ा²ा   उ प यो गउ प यो ग
हैहै ??

A nsA ns 1. ईमेल टेą�ेट ि¦एट करना
2. बड़े  अटैचम�ट स�ड करना
3. �ैम ईमेल को Ćॉक करना
4. ईमेल úाइंट और सवaर के बीच कनेøन को सुर�bत करना

Q .66Q .66 को ईको ई   यूजरयूजर   �व ंडो ज�व ंडो ज   ऑ प रे िटंगऑ प रे िटंग   �स�म�स�म   म�म�   िड ��ेिड ��े   सेिटंĈसेिटंĈ   कोको   कै सेकै से   बद लबद ल   सक तासक ता   हैहै ??
A nsA ns 1. Start > Settings > System > Control सेलेf करके

2. Start > Settings > System > Panel सेलेf करके
3. Start > Settings > System > Display सेलेf करके
4. Start > Settings > System > Devices सेलेf करके

Q .67Q .67 िक सिक स   � का र� का र   काका   मैलवेयरमैलवेयर   अ�रअ�र   नेट वकaनेट वकa   क नेø नक नेø न   केके   मा Cममा Cम   सेसे   फैलताफैलता   हैहै   औ रऔ र   मा नवी यमा नवी य   हKbेपहKbेप   केके   �बना�बना
³यं³यं   कोको   डु ĉ�के टडु ĉ�के ट   बना नेबना ने   क]क]   bमताbमता   र ख तार ख ता   हैहै ??

A nsA ns 1. वाइरस (Virus)
2. टN ोजन हॉसa (Trojan horse)
3. �ाइवेयर (Spyware)
4. वमa (Worm)
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Q .68Q .68 G mail  G mail  जैसीजैसी   सा इट�सा इट�   यूज़सaयूज़सa   कोको   अप नीअप नी   मशी न�मशी न�   प रप र   मेलमेल   डा उ नलो डडा उ नलो ड   क र नेक र ने   म�म�   सbमसbम   बना नेबना ने   केके   �लए�लए   िक निक न
अ�त ~र Lअ�त ~र L   �ो टो कॉ ल�ो टो कॉ ल   कोको   सपो टaसपो टa   क र तीक र ती   हÁहÁ ??

A nsA ns 1. POP और SMTP
2. IMAP और POP
3. SMTP और IMAP
4. HTTP और FTP

Q .69Q .69 ई मेलई मेल   úा इंटúा इंट   �ा रा�ा रा   संदे शसंदे श   भेजनेभेजने   केके   �लए�लए   सा मा Þ तःसा मा Þ तः   िक सिक स   �ो टो कॉ ल�ो टो कॉ ल   काका   उ प यो गउ प यो ग   िक यािक या   जा ताजा ता   हैहै ??
A nsA ns 1. HTTP

2. FTP
3. SMTP
4. POP

Q .70Q .70 एमएसएमएस   वडaवडa   म�म�   एला इनम�टएला इनम�ट  (a l ignment)   (a l ignment)  केके   मु¸मु¸   चा रचा र   � का र� का र   कौ नकौ न -- सेसे   हÁहÁ ??
A nsA ns 1. लेö एलाइनम�ट, राइट एलाइनम�ट, कॉमन एलाइनम�ट और ज��फाई एलाइनम�ट

2. लेö एलाइनम�ट, राइट एलाइनम�ट, स�टर एलाइनम�ट और ज��फाई एलाइनम�ट
3. लेö एलाइनम�ट, राइट एलाइनम�ट, स�टर एलाइनम�ट और रैप एलाइनम�ट
4. लेö एलाइनम�ट, राइट एलाइनम�ट, मजa एलाइनम�ट और ज��फाई एलाइनम�ट

Q .71Q .71 एकएक   नयानया   ĆÁकĆÁक   एमएसएमएस   पा वर पॉ इंटपा वर पॉ इंट   � ेज�टे शन�ेज�टे शन   ि¦ एटि¦ एट   क र नेक र ने   केके   �लए�लए ,  ,  �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   चर णचर ण   काका
पा लनपा लन   िक यािक या   जा नाजा ना   चा �हएचा �हए ??

A nsA ns 1. File > Save As > New Presentation
2. File > New > From Template
3. File > Open > Recent Presentations
4. File > New > Blank Presentation

Q .72Q .72 M S  PowerPoint  M S  PowerPoint  म�म� ,  ,  जबजब   आ पआ प   िक सीिक सी   � ेज�टे शन�ेज�टे शन   केके   �ा इल�ा इल   औ रऔ र   लेआ उ टलेआ उ ट   केके   �लए�लए   टे ċ लेटटे ċ लेट   काका   उ प यो गउ प यो ग
क र तेक र ते   हÁहÁ ,  ,  तोतो   �न��न�   म�म�   सेसे   ²ा²ा   हो ताहो ता   हैहै ??

A nsA ns 1. ये चुने गए टेċलेट के अनुसार सेट होते हÁ।
2. ये मानक एमएस पावरपॉइंट सेिटंĈ पर िडफ़ॉČ होते हÁ।
3. ये ³तः िपछली �ेज�टेशन सेिटंĈ म� एडज� हो जाते हÁ।
4. ये मैÞुअल (प से कॉिĄफ़गर िकए जाने तक ĆÁक रहते हÁ।
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Q .73Q .73 को ईको ई   यूजरयूजर   �व ंडो ज�व ंडो ज   ऑ प रे िटंगऑ प रे िटंग   �स�म�स�म   म�म�   पा वरपा वर   से�व ंगसे�व ंग   मो डमो ड   कोको   कै सेकै से   इनेबलइनेबल   क रक र   सक तासक ता   हैहै ??
A nsA ns 1. Start > Settings > System > Power & battery > Screen सेलेf करके

2. Start > Settings > System > Power & battery > Energy Saver सेलेf करके
3. Start > Settings > System > Power & battery > Energy usage सेलेf करके
4. Start > Settings > System > Power & battery > Sleep सेलेf करके

Q .74Q .74 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सासा   क थनक थन   वा इडवा इड   ए ~र याए ~र या   नेट वकaनेट वकa  ( WA N)   ( WA N)  काका   सवÿ � मसवÿ � म   वणaनवणaन   क र ताक र ता   हैहै ??
A nsA ns 1. एक नेटवकa  जो िकसी वृहद भौगो�लक bेc, �ायः एक देश या महा�ीप म� फैला होता है, और कई लोकल

ए~रया नेटवकa  (LAN) को जोड़ता है
2. एक नेटवकa  जो िकसी छोटे भौगो�लक bेc को कवर करता है, जैसे िक एक इमारत या एक प~रसर
3. एक नेटवकa  जो ·�Lगत कायa>ल पर Ďाटaफ़ोन, टैबलेट और लैपटॉप जैसे ·�Lगत िडवाइस को जोड़ने

के �लए िडज़ाइन िकया गया है
4. एक नेटवकa  जो एक कमरे या आस-पास के कमर� के एक छोटे समूह के िडवाइस� को जोड़ता है

Q .75Q .75 य�दय�द   आ पआ प   {ा उ ज़र{ा उ ज़र   �व ंडो�व ंडो  ( ( जैसेजैसे   ग ूग लगूग ल   ¦ो म¦ो म )  )  केके   ऊप रFऊप रF   दा एंदा एं   को नेको ने   म�म�   मौ जूदमौ जूद   ती नती न   विटa क लविटa क ल   डॉ ट्सडॉ ट्स   आ इक नआ इक न
(( विटa क लविटa क ल   डॉ ट्सडॉ ट्स )  )  प रप र   ùúकùúक   क र तेक र ते   हÁहÁ   औ रऔ र   � द �शaत� द �शaत   मेनूमेनू   सेसे  'S ett ings '   'S ett ings '  आ प्आ प्शनशन   प रप र   जा तेजा ते   हÁहÁ ,  ,  तोतो   ओ प नओ प न
िक एिक ए   ग एग ए   नएनए   टै बटै ब   सेसे ,  ,  �न��ल	ख त�न��ल	ख त   म�म�   सेसे   कौ नकौ न -- सीसी   सेिटंगसेिटंग   च�जच�ज   क]क]   जाजा   सक तीसक ती   हैहै ??

i .  i .  सेिटंĈसेिटंĈ   ऑ फऑ फ   पी प लपी प ल  ( S ett ings  of people) ( S ett ings  of people)
i i .  i i .  अपी यर� सअपी यर� स  ( A ppearance)   ( A ppearance)  
i i i .  i i i .  सचaसचa   इंजनइंजन  ( S earc h E ngines)   ( S earc h E ngines)  
iv.  iv.  िड फॉ ल्िड फॉ ल्टट   {ा उ ज़र{ा उ ज़र  ( Default  Brows er  )   ( Default  Brows er  )  
v.  v.  स्स्टा टa अपटा टa अप   एंडएंड   एड व+ सएड व+ स   टै ब्टै ब्सस  ( S tartup and A dvance Tabs) ( S tartup and A dvance Tabs)

A nsA ns 1. केवल iii, iv और v
2. केवल ii, iii और iv
3. i, ii, iii, iv और v
4. केवल i, ii और iii

Q .76Q .76 एमएसएमएस   वडaवडa   काका   कौ नकौ न -- सासा   टै बटै ब ,  ,  यूजरयूजर   कोको   डॉ ²ूम�टडॉ ²ूम�ट   केके   सा इजसा इज   कोको   क �मा इजक �मा इज   क र नेक र ने   क]क]   सु�वधासु�वधा   दे तादे ता   हैहै ??
A nsA ns 1. View

2. Design
3. Home
4. Layout
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Q .77Q .77 Whic h feature in an email  c l ient  a l lows  y ou to  organis e emai ls  bas ed on c r iter iaWhic h feature in an email  c l ient  a l lows  y ou to  organis e emai ls  bas ed on c r iter ia
s uc h as  s ender,  date or  s ubjec t?s uc h as  s ender,  date or  s ubjec t?

A nsA ns 1. Filtering
2. Archiving
3. Sorting
4. Searching

Q .78Q .78 आ प कोआ प को   सा वaज�नकसा वaज�नक  Wi- Fi   Wi- Fi  काका   उ प यो गउ प यो ग   क र केक र के   अप नेअप ने   Ďा टa फो नĎा टa फो न   प रप र   मह� पूणaमह� पूणa   लेनदे नलेनदे न   क र नेक र ने   सेसे   ²�²�   बचनाबचना
चा �हएचा �हए ??

A nsA ns 1. इससे �ोसेस क] स्पीड बढ़ जाती है
2. सावaज�नक Wi-Fi नेटवकa  �ायः असुर�bत होते हÁ और उनका उपयोग संवेदनशील जानकारF को चुराने के

�लए िकया जा सकता है।
3. यह मोबाइल डेटा सेव करने म� सहायता करता है।
4. यह सशुď सेवाओं तक मुĐ एक्सेस क] सु�वधा देता है।

Q .79Q .79 �न��ल	ख त�न��ल	ख त   म�म�   सेसे   िक सिक स   �वक Î�वक Î   �ा रा�ा रा   ऐसेऐसे   डॉ ²ूम�टडॉ ²ूम�ट   क]क]   खो जखो ज   क र नेक र ने   क]क]   सु�वधासु�वधा   � दा न� दा न   क]क]   जा तीजा ती   हैहै   जोजो
ओ प नओ प न   डा यलॉ गडा यलॉ ग   बॉ �बॉ �  (O pen d ia log box)   (O pen d ia log box)  म�म�   � भा वी� भा वी   ( प( प   सेसे   सेवसेव   नह´नह´   हुआहुआ   थाथा ??

A nsA ns 1. ओपन एंड ~रपेयर (Open and Repair)
2. ~रकवर अनसेđ डॉ²ूम�ट्स (Recover Unsaved Documents)
3. कċैिट�ब�लटी मोड (Compatibility Mode)
4. �ोटेfेड ·ू (Protected View)

Q .80Q .80 Whic h of the fo l lowing c harac ter is t ic s  would  y ou apply  to  loc ate works heet cel lsWhic h of the fo l lowing c harac ter is t ic s  would  y ou apply  to  loc ate works heet cel ls
that  s at is fy  part ic ular  requirements?that  s at is fy  part ic ular  requirements?

A nsA ns 1. Conditional Formatting
2. Sort
3. Auto Sum
4. Data Table

Section : Quantitative Aptitude
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Q .81Q .81 एकएक   आ द मीआ द मी   अप नीअप नी   आ धीआ धी   या cाया cा  5 km/ hr   5 km/ hr  क]क]   चा लचा ल   सेसे   त थात था   शेषशेष   आ धीआ धी   या cाया cा  3  km/ hr   3  km/ hr  क]क]   चा लचा ल   सेसे   त यत य
क र ताक र ता   हैहै । । उ सक]उ सक]   औ सतऔ सत   चा लचा ल  ( km/ hr   ( km/ hr  म�म� )  )  āा तāा त   क] �जएक] �जए ।।

A nsA ns 1. 4.15
2. 3.75
3. 3.55
4. 4

Q .82Q .82 एकएक   क bाक bा   म�म�  1 5  1 5 �व�ा \थaय��व�ा \थaय�   केके   अंक�अंक�   काका   औ सतऔ सत  4 9  4 9 हैहै । । य �दय�द   � »ेक� »ेक   �व�ा थ4�व�ा थ4   केके   अंकअंक   दो गुनेदो गुने   क रक र   �द ए�द ए   जा एंजा एं ,,
तोतो   नयानया   औ सतऔ सत   āा तāा त   क] �जएक] �जए ।।

A nsA ns 1. 98
2. 30
3. 49
4. 15

Q .83Q .83 एकएक   · �L· �L   अप नीअप नी   आ यआ य   काका  60 %  60 % बचा ताबचा ता   हैहै । । य �दय�द   उ सकाउ सका   · य· य  ₹680   ₹680  हैहै ,  ,  तोतो   उ सक]उ सक]   आ यआ य  ( ₹   ( ₹  म�म� )  )  क्क् याया
हो गीहो गी ??

A nsA ns 1. 700
2. 1,700
3. 1,740
4. 840

Q .84Q .84 4 0  4 0  प ुKक�पुKक�   काका   �व¦ य�व¦ य   मू�मू� , 6  ,  6  प ुKक�पुKक�   केके   ¦ य¦ य   मू�मू�   केके   बरा बरबरा बर   हैहै । । हा �नहा �न   याया   ला भला भ   � �त शत� �त शत   āा तāा त   क] �जएक] �जए ।।
A nsA ns 1. हा�न

2. लाभ
3. हा�न
4.  लाभ

Q .85Q .85 5 5 वषaवष a   प हलेप हले   र �वर �व   क]क]   आ युआ यु ,  ,  रो �हतरो �हत   क]क]   आ युआ यु   क]क]   प+ चप+ च   गुनागुना   थीथी । 4  । 4  वषaवष a   प हलेप हले   र �वर �व   क]क]   आ युआ यु ,  ,  रो �हतरो �हत   क]क]   आ युआ यु
क]क]   चा रचा र   ग ुनागुना   थीथी । 6  । 6  वषaवष a   प हलेप हले   रो �हतरो �हत   क]क]   आ युआ यु ,  ,  र �वर �व   क]क]   आ युआ यु   क]क]   िक त नीिक त नी   ग ुनागुना   थीथी ??

A nsA ns 1. 6 गुना
2. 8 गुना
3. 5 गुना
4. 7 गुना
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Q .86Q .86 एकएक   �व�ा लय�व�ा लय   म�म�   सभीसभी   �शbक��शbक�   काका   औ सतऔ सत   वेत नवेत न  ₹1 2 ,0 0 0   ₹1 2 ,0 0 0  हैहै । 8  । 8  व~र ôव~र ô   �शbक��शbक�   काका   औ सतऔ सत   वेत नवेत न
₹1 5,0 0 0  ₹1 5,0 0 0  हैहै   औ रऔ र   शेषशेष   �शbक��शbक�   काका   औ सतऔ सत   वेत नवेत न  ₹8 ,0 0 0   ₹8 ,0 0 0  हैहै । । �व�ा लय�व�ा लय   म�म�   �शbक��शbक�   क]क]   कु लकु ल   सं¸ासं¸ा   āा तāा त
क] �जएक] �जए ।।

A nsA ns 1. 14
2. 15
3. 12
4. 13

Q .87Q .87 एकएक   सं¸ासं¸ा   म�म�   प हलेप हले  1 0 %  1 0 % क]क]   वृ«�वृ«�   क]क]   जा तीजा ती   हैहै ,  ,  िफरिफर  2 0 %  2 0 % क]क]   वृ«�वृ«�   क]क]   जा तीजा ती   हैहै ,  ,  औ रऔ र   िफरिफर  3 0 %  3 0 % क]क]
क मीक मी   क]क]   जा तीजा ती   हैहै । । ती नती न   ¦ �मक¦ �मक   � �त शत� �त शत   प ~र वतaनप ~र वतaन   दे नेदे ने   केके   बा दबा द ,  ,  सं¸ासं¸ा   म�म�   शु�शु�   � �त शत� �त शत   प ~र वतaनप ~र वतaन   िक त नािक त ना
हो गाहो गा ??

A nsA ns 1. 7.6% कमी
2. 8.5% वृ«�
3. 10.4% वृ«�
4. 6.4% कमी

Q .88Q .88 ¦ मशः¦ मशः  4 4%, 89%  4 4%, 89% औ रऔ र  3 4%  3 4% क]क]   ती नती न   ¦ �मक¦ �मक   छूट�छूट�   केके   बरा बरबरा बर   एक लएक ल   � �त शत� �त शत   छूटछूट  [ [ द शमलवद शमलव   केके  1   1  >ा न>ा न
त कत क ]  ]  āा तāा त   क] �जएक] �जए ।।

A nsA ns 1. 
2. 
3. 
4. 

Q .89Q .89 �न��ल	ख त�न��ल	ख त   काका   मा नमा न   āा तāा त   क] �जएक] �जए ::
3 5 − [ 2 5 − { 3 1  − ( 2 1  − 1 4  + 9) } ]3 5 − [ 2 5 − { 3 1  − ( 2 1  − 1 4  + 9) } ]

A nsA ns 1. 28
2. 25
3. 24
4. 22
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Q .90Q .90 �न��ल	ख त�न��ल	ख त   काका   मा नमा न   āा तāा त   क] �जएक] �जए ::

1 850  − [ 4 50  − { 2 1 0  − ( 90  − 60  − 8) } ]1 850  − [ 4 50  − { 2 1 0  − ( 90  − 60  − 8) } ]
A nsA ns 1. 1663

2. 1448
3. 1588
4. 1518

Q .91Q .91   काका   मा नमा न   āा तāा त   क] �जएक] �जए ।।
A nsA ns 1. 23.194

2. 24.184
3. 21.384
4. 23.184

Q .92Q .92 सा तसा त   आ द मीआ द मी   िक सीिक सी   का यaका यa   कोको  1 2   1 2  �द न��द न�   म�म�   प ूराप ूरा   क रक र   सक तेसक ते   हÁहÁ । । वेवे   का यaका यa   शु(शु(   क र तेक र ते   हÁहÁ   औ रऔ र  5  5 �द न�द न   बा दबा द  3 3
आ द मीआ द मी   का यaका यa   छो ड़छो ड़   दे त ेदे त े   हÁहÁ । । शेषशेष   आ द �मय�आ द �मय�   �ा रा�ा रा   शेषशेष   का यaका यa   िक त नेिक त ने   �द न��द न�   म�म�   प ूराप ूरा   िक यािक या   जा एगाजा एगा ??

A nsA ns 1. 

2. 

3. 
4. 

Q .93Q .93 य�दय�द  x   x  काका  4% = 2 52 ,   4% = 2 52 ,  तोतो  x   x  �नम्�नम्नन   म�म�   सेसे   िक सकेिक सके   बरा बरबरा बर   हैहै ??
A nsA ns 1. 12600

2. 6300
3. 6400
4. 12700

Q .94Q .94 एकएक   नलनल   कोको   िक सीिक सी   �वशेष�वशेष   टÁ कटÁ क   कोको   भर नेभर ने   म�म�  1 2 0 0   1 2 0 0  सेकं डसेकं ड   लग तालग ता   हैहै । । इसीइसी   बी चबी च ,  ,  उ सीउ सी   टÁ कटÁ क   कोको   भर नेभर ने   म�म�   दूस रेदूस रे
नलनल   कोको  3 0   3 0  �मनट�मनट   लग तालग ता   हैहै । । य �दय�द   दो न�दो न�   नल�नल�   कोको   एकएक   हीही   समयसमय   प रप र   खो लाखो ला   जा एजा ए ,  ,  तोतो   टÁ कटÁ क   कोको   भर नेभर ने   म�म�   लग नेलग ने
वा लावा ला   समयसमय  ( ( �मनट�मनट   म�म� )  )  āा तāा त   क] �जएक] �जए ।।

A nsA ns 1. 12
2. 19
3. 20
4. 15
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Q .95Q .95 दोदो   ¦ �मक¦ �मक   छूटछूट   �मलने�मलने   केके   बा दबा द ,  ₹3,0 0 0  ,  ₹3,0 0 0  अंिक तअंिक त   मू�मू�   वा लीवा ली   एकएक   मेजमेज  ₹2 ,1 60   ₹2 ,1 60  म�म�   उ प लęउ प लę   हैहै । । य �दय�द   दूसरFदूसरF
छूटछूट  2 0 %  2 0 % थीथी ,  ,  तोतो   प हलीप हली   छूटछूट   āा तāा त   क] �जएक] �जए ।।

A nsA ns 1. 8%
2. 5%
3. 10%
4. 15%

Q .96Q .96 एकएक   रे लगा ड़ीरे लगा ड़ी  1 50  km  1 50  km क]क]   दूरFदूरF  1 0 0  km/ hr   1 0 0  km/ hr  क]क]   चा लचा ल   सेसे   त यत य   क र तीक र ती   हैहै   औ रऔ र   िफरिफर  90  km  90  km क]क]   दूरFदूरF  1 80 1 80
km/ hr km/ hr  क]क]   चा लचा ल   सेसे   त यत य   क र तीक र ती   हैहै । । प ूरFप ूरF   दूरFदूरF   केके   �लए�लए   रे लगा ड़ीरे लगा ड़ी   क]क]   औ सतऔ सत   चा लचा ल   āा तāा त   क] �जएक] �जए ।।

A nsA ns 1. 140 km/hr
2. 150 km/hr
3. 160 km/hr
4. 120 km/hr

Q .97Q .97 य�दय�द     हैहै ,  ,  तोतो     काका   मा नमा न   āा तāा त   क] �जएक] �जए ।।

A nsA ns 1. 
            

2 . 

3. 
           

4. 
           

Q .98Q .98 अ�नलअ�नल   औ रऔ र   अंिक तअंिक त   क]क]   आ युआ यु   काका   अनुपा तअनुपा त  9  :  4   9  :  4  हैहै । 2  । 2  वषaवष a   बा दबा द ,  ,  उ नक]उ नक]   आ युआ यु   काका   अनुपा तअनुपा त  2  :  1   2  :  1  हो गाहो गा ।।
अ�नलअ�नल   क]क]   आ युआ यु   āा तāा त   क] �जएक] �जए ।।

A nsA ns 1. 20 वषa
2. 16 वषa
3. 18 वषa
4. 8 वषa
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Q .99Q .99 एकएक   खुद राखुद रा   �व¦े ता�व¦े ता  ₹1 75  ₹1 75 म�म�   एकएक   इलेfN ॉ �नकइलेfN ॉ �नक   वKुवKु   ख रF द ताख रF द ता   हैहै । । उ सप रउ सप र   उ प ~र · यउ प ~र · य  ₹2 5  ₹2 5 हैहै । । वहवह   उ सउ स
इलेfN ॉ �नकइलेfN ॉ �नक   वKुवKु   कोको  ₹50 0   ₹50 0  म�म�   बेचताबेचता   हैहै   औ रऔ र  x%  x% ला भला भ   अ�जaतअ�जaत   क र ताक र ता   हैहै । x  । x  काका   मा नमा न   āा तāा त   क] �जएक] �जए ।।

A nsA ns 1. 170
2. 140
3. 130
4. 150

Q .1 0 0Q .1 0 0 दोदो   उ �ी द वा र�उ �ी द वा र�   केके   बी चबी च   एकएक   चुना वचुना व   म�म� ,  80 % ,  80 % मत दा ता ओंमत दा ता ओं   नेने   अप नेअप ने   वो टवो ट   डा लेडा ले । । �जसम��जसम� ,  4 80  ,  4 80  वो टवो ट   अवैधअवैध
घो िष तघो िष त   िक एिक ए   ग एग ए । । �वजेता�वजेता   कोको   अप नेअप ने   � �त �ं�ी� �त �ं�ी   सेसे  1 568  1 568 वो टवो ट   अ\धकअ\धक   �मले�मले । । य �दय�द   �वजेता�वजेता   कोको   प ंजी कृ तपंजी कृ त   वो ट�वो ट�
काका  4 2 %  4 2 % �ा }�ा }   हो ताहो ता   हैहै ,  ,  तोतो   िक त नेिक त ने   मत दा ता ओंमत दा ता ओं   नेने   अप नेअप ने   वो टवो ट   डा लेडा ले ??

A nsA ns 1. 27,000
2. 21,670
3. 27,200
4. 21,760
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